HOW TO USE

EXCEL®
IN ANALYTICAL
CHEMISTRY
AND IN GENERAL SCIENTIFIC
DATA ANALYSIS

Robert de Levie
Bowdoin College, Brunswick, ME
CONTENTS

Preface [xi]

PART I INTRODUCTION TO USING THE SPREADSHEET

1 How to use Excel [1]
   1.1 Starting Windows [2]
   1.2 A first look at the spreadsheet [3]
   1.3 A simple spreadsheet and graph [7]
      1.3a Making a graph in Excel 97 or a more recent version [9]
      1.3b Making a graph in Excel 5 or Excel 95 [11]
   1.4 Addressing a spreadsheet cell [13]
   1.5 More on graphs [15]
   1.6 Mathematical operations [21]
   1.7 Error messages [26]
   1.8 Naming and annotating cells [27]
   1.9 Viewing the spreadsheet [28]
   1.10 Printing [29]
   1.11 Help! [30]
   1.12 The case of the changing options [31]
   1.13 Importing macros and data [32]
   1.14 Differences between the various versions of Excel [33]
   1.15 Some often-used spreadsheet commands [35]
   1.16 Changing the default settings [36]
   1.17 Summary [37]

PART II STATISTICS AND RELATED METHODS

2 Introduction to statistics [39]
   2.1 Gaussian statistics [39]
   2.2 Replicate measurements [45]
2.3 The propagation of imprecision from a single parameter [51]
2.4 The propagation of imprecision from multiple parameters [54]
2.5 The weighted average [58]
2.6 Least-squares fitting to a proportionality [60]
2.7 Least-squares fitting to a general straight line [66]
2.8 Looking at the data [71]
2.9 What is ‘normal’? [73]
2.10 Poissonian statistics [78]
2.11 How likely is the improbable? [79]
2.12 Summary [83]

3 More on least squares [90]
3.1 Multi-parameter fitting [90]
3.2 Fitting data to a quadratic [93]
3.3 Least squares for equidistant data: smoothing and differentiation [94]
3.4 Weighted least squares [99]
3.5 Another example of weighted least squares: enzyme kinetics [103]
3.6 Non-linear data fitting [105]
   3.6a Some kinetic data [106]
   3.6b A double exponential [108]
   3.6c False minima [115]
   3.6d Enzyme kinetics revisited [116]
   3.6e SolverAid [117]
3.7 Summary [118]

PART III CHEMICAL EQUILIBRIUM

4 Acids, bases, and salts [121]
4.1 The mass action law and its graphical representations [121]
4.2 Conservation laws, proton balance, and pH calculations [127]
4.3 Titrations of monoprotic acids and bases [130]
4.4 Schwartz and Gran plots [133]
4.5 The first derivative [136]
4.6 A more general approach to data fitting [142]
4.7 Buffer action [146]
4.8 Diprotic acids and bases, and their salts [148]
4.9 Polyprotic acids and bases, and their salts [152]
4.10 Activity corrections [155]
4.11 A practical example [161]
4.12 Summary [172]

5 Other ionic equilibria [175]
5.1 Complex formation [175]
5.2 Chelation [180]
5.3 Extraction [182]
5.4 Solubility [185]
5.5 Precipitation and dissolution [190]
5.6 Precipitation titrations [194]
5.7 The von Liebig titration [200]
5.8 The graphical representation of electrochemical equilibria [204]
5.9 Redox titrations [211]
5.10 Redox buffer action [217]
5.11 Summary [220]

PART IV INSTRUMENTAL METHODS
6 Spectrometry, chromatography, and voltammetry [223]
6.1 Spectrometric pK_a determination [223]
6.2 Multi-component spectrometric analysis 1 [225]
6.3 Multi-component spectrometric analysis 2 [227]
6.4 The absorbance–absorbance diagram [231]
6.5 Chromatographic plate theory 1 [234]
6.6 Chromatographic plate theory 2 [239]
6.7 Peak area, position, and width [243]
6.8 Determining the number of theoretical plates [245]
6.9 Optimizing the mobile phase velocity [248]
6.10 Polarography [251]
6.11 Linear sweep and cyclic voltammetry 1 [257]
6.12 Linear sweep and cyclic voltammetry 2 [261]
6.13 Summary [263]

PART V MATHEMATICAL METHODS
7 Fourier transformation [265]
7.1 Introduction to Fourier transformation [265]
7.2 Interpolation and filtering [277]
7.3 Differentiation [285]
7.4 Aliasing and leakage [288]
7.5 Convolution [295]
7.6 Deconvolution [304]
7.7 Summary [309]

8 Standard mathematical operations [311]
8.1 The Newton–Raphson method [311]
8.2 Non-linear least squares [313]
8.3 Signal averaging [314]
8.4 Lock-in amplification [316]
8.5 Data smoothing [318]
8.6 Peak fitting [324]
8.7 Integration [328]
8.8 Differentiation [331]
8.9 Semi-integration and semi-differentiation [335]
8.10 Interpolation [336]
8.11 Matrix manipulation [337]
8.12 Overflow [341]
8.13 Summary [343]

9 Numerical simulation of chemical kinetics [345]
9.1 Introduction [345]
9.2 The explicit method [346]
  9.2a First-order kinetics [346]
  9.2b Numerical accuracy [348]
  9.2c Dimerization kinetics [350]
  9.2d A user-defined function to make the spreadsheet more efficient [351]
  9.2e Trimerization kinetics [353]
  9.2f Monomer–dimer kinetics [354]
  9.2g Polymerization kinetics [355]
9.3 Implicit numerical simulation [359]
  9.3a First-order kinetics [359]
  9.3b Dimerization kinetics [360]
  9.3c Trimerization kinetics [361]
  9.3d Monomer–dimer kinetics [362]
  9.3e Polymerization kinetics [363]
9.4 Some applications [365]
  9.4a Autocatalysis [365]
  9.4b Heterogeneous catalysis [367]
  9.4c The steady-state approximation [369]
  9.4d Oscillating reactions: the Lotka model [372]
9.5 Summary [374]

PART VI SPREADSHEET PROGRAMMING

10 Some useful macros [375]
10.1 What is a macro? [375]
  10.1a The macro module [376]
  10.1b Reading and modifying the contents of a single cell [378]
  10.1c Reading and modifying the contents of a block of cells [382]
  10.1d Two different approaches to modifying a block of cells [384]
  10.1e Numerical precision [387]
## Contents

10.1f Communication via boxes  [389]

10.1g Subroutines  [393]

10.2 A case study: interpolating in a set of equidistant data  [395]
   10.2a Step-by-step  [396]
   10.2b The finished product  [401]

10.3 Propagation of imprecision  [405]

10.4 Installing and customizing a macro  [410]
   10.4a Installing external macros  [410]
   10.4b Assigning a shortcut key  [411]
   10.4c Embedding in a menu  [412]
   10.4d Miscellany  [414]

10.5 Fourier transformation  [415]
   10.5a Forward Fourier transformation  [416]
   10.5b Descriptive notes  [420]
   10.5c A bidirectional Fourier transformation macro  [421]

10.6 Convolution and deconvolution  [426]

10.7 Weighted least squares  [432]
   10.7a The algorithm  [432]
   10.7b Implementation  [433]

10.8 More about Solver  [442]
   10.8a Adding uncertainty estimates to Solver  [442]
   10.8b Incorporating Solver into your macro  [448]

10.9 Smoothing and differentiating equidistant data  [449]

10.10 Semi-integration and semi-differentiation  [460]

10.11 Reducing data density  [463]

10.12 An overview of VBA  [466]
   10.12a Objects  [467]
   10.12b Properties and methods  [467]
   10.12c Data types  [468]
   10.12d Expressions  [469]
   10.12e Statements  [470]
   10.12f Active regions  [470]
   10.12g Cells  [471]
   10.12h Ranges  [472]
   10.12i Subroutines  [473]
   10.12j Macros  [474]
   10.12k Functions  [474]
   10.12l Message boxes  [475]
   10.12m Input boxes  [475]
   10.12n Dialog boxes  [476]
   10.12o Collective statements  [476]
   10.12p For…Next loops  [477]
   10.12q Do loops  [478]
Contents

10.12r Conditional statements  [479]
10.12s Exit statements  [480]
10.13 Summary  [481]

Index  [483]
First things first: this introductory chapter is intended for readers who have no prior experience with Excel, and only provides the minimum information necessary to use the rest of this book. Emphatically, this chapter is not meant to replace a spreadsheet manual; if it were, that part alone would occupy more space than that of this entire workbook. Instead, during and after using this workbook, you may be tempted to consult an Excel manual (of which there will be several in your local library and bookstore) to learn what else it can do for you – but that is up to you.

Second: this book is not intended to be read, but instead to be used while you sit at the computer keyboard, trying out whatever is described in the text. Learning to use a spreadsheet is somewhat like learning to swim, to ride a bicycle, or to paint: you can only learn it by doing it. So set aside a block of time (one or two hours should do for this chapter, unless you are really new to computers, in which case you might want to reserve several such sessions in order to get acquainted), make yourself comfortable, turn on the computer, and try things out as they are described in, say, the first three sections of this chapter. (If it confuses you on your first try, and there is nobody at hand to help you along, stop, do something else, and come back to it later, or the next day, but don’t give up.) Then try the next sections.

In order to run Excel (or any other spreadsheet program), your computer will need an operating system. Here we will assume that you have Windows as the operating system on your personal computer, and that you have a compatible version of Excel. Although there are relatively minor differences between the various versions of Excel, they fall roughly into three categories. Excel versions 1 through 4 did not use VBA as their macro language, and the macros described and used in this book will therefore not run on them. The second category includes Excel 5 and Excel 95 (also called Excel version 7; there never was a version 6), which use VBA with readily accessible modules. Excel 97, Excel 98 (for the Mac), and Excel 2000 make up the third category, which has macro modules that are hidden from sight. The instructions given
in this book are specifically for the second and third categories, starting with Excel 5. While they were mostly tested in Excel 97, all versions more recent than Excel 4 will do fine for most of the spreadsheet exercises in this book. Because Excel is *backward compatible*, you can run older software in a more recent version, but not necessarily the other way around.

When you have a Macintosh, your operating system will be different, but Excel will be very similar. After all, both IBM and Mac versions of Excel were written by Microsoft. With relatively minor modifications, mostly reflecting differences between the IBM and Mac keyboards, all exercises in this book will run on the Mac, provided you have Excel version 5 or later.

In either case, whether you use an IBM-compatible PC or a Macintosh, use at least Excel version 5, because earlier versions lacked some of the more useful features of Excel that will be exploited in this book. If you have Excel 4 or earlier, it is time to upgrade.

When you are already familiar with earlier versions of Windows and Excel, you may want to use this chapter as a refresher, or scan the text quickly and then go directly to the next chapter. When you are already familiar with Windows 95 or Windows 98, and with Excel 95 or 97, you may skip this chapter altogether.

### 1.1 Starting Windows

Windows is a so-called *graphical* user interface, in which many programs, files, and instructions are shown pictorially, and in which many operations can be performed by ‘pointing and clicking’, an approach pioneered in the early 1970s by the Xerox Corporation, and long familiar to Macintosh users. The pointing device is usually a *mouse* or a *trackball*; for many instructions, equivalent typed commands can be used as well. We will use ‘mouse’ as the generic term for whatever pointing device you may have. There are often several ways to let the computer know what you want it to do. Here we will usually emphasize how to do it with the mouse, because most users find that the easiest.

In what follows we will assume that Windows and Excel have been installed in their complete, standard forms. For some applications we will also use the Solver and the Analysis Toolpak. These come with Excel, but (depending on the initial installation) may have to be loaded as an add-in.

When you start Windows, your monitor will show a screen (the *desktop*) which typically displays, on its left side, a number of pictures (icons), each with its own explanatory label. The bottom icon is labeled ‘Start’, and acts as the *on switch* of Windows. (There is no simple *off* switch, since Windows requires a more elaborate turn-off routine, which rather illogically begins with the Start button, and via the Shut Down command leads you to the Shut Down Windows dialog box, where you can choose between several options.)
Icons, such as the start label, are also called buttons, as if you could actually push them. Move the mouse so that the sharp point of the arrow on the screen, the pointer, indeed ‘points to’ (i.e., is inside) the start button, and press the left mouse button once. (Left and right depend, of course, on the orientation of the mouse. By ‘left’ we mean the left button when the two or three mouse buttons are pointing away from you, so that you can hold the body of the mouse with your thumb and index finger, or with the palm of your hand, while your index finger, middle finger, and ring finger can play with the buttons.) To briefly depress the left mouse button we will call to click the mouse; when you need to do this twice in quick succession we will call it double clicking, whereas briefly depressing the right mouse button we will call right clicking.

As soon as you have clicked the start button, a dialog box will pop up above it, showing you a number of choices. Manipulate the mouse so that the arrow points to ‘Programs’, which will now be highlighted, and click. A second dialog box will pop up next to the first to show you the various programs available. One of these will be Excel; click on it to start the spreadsheet. Alternatively, click on the Excel icon if the desktop shows it.

1.2 A first look at the spreadsheet

After displaying the Excel logo, the monitor screen will show you a rather busy screen, as illustrated in Fig. 1.2-1. The actual screen you will see may have more bars, or fewer, depending on how the screen has been configured. Please ignore such details for the moment; few if any of the instructions to follow will depend on such local variations.

At the top of the screen is the title bar. In its right-hand corner are three icon buttons, to minimize the screen to near-zero size, to restore it to medium or full size, and to close it. To the left on the same bar you will find the Excel logo and the name of the file you use, where ‘file’ is the generic name for any unit in which you may want to store your work. Below the title bar is the menu bar (with such menu headings as File, Edit, View, Insert, etc.). This is usually followed by a standard bar with icons (pictograms showing an empty sheet, an opening file folder, a diskette, a printer, etc.) and a formula bar. At this point, the latter will show two windows, of which the larger one will be empty.

Starting from the bottom of the screen and moving upwards, we usually first encounter the task bar, which has the Start button in its left corner. Next to the start button you will find the name of the Workbook you are using. When you have not yet given it a name, Excel will just call it Book1, Book2, etc. Above the task bar is the status bar, which may be largely empty for now.
What we have described so far is the frame around the actual spreadsheet. Now we come to the spreadsheet itself, which is called a workbook, and is organized in different pages.

Above the status bar you will find a tab, in Fig. 1.2-2 labeled Sheet1, which identifies which page of the work book is open. Here, then, you see the general organization of individual spreadsheet pages into workbooks. You can have as many pages in your workbook as you wish (by adding or removing sheets), and again as many different workbooks as you desire. For the exercises in the present text, you may want to use a new sheet for each exercise, and a new workbook for each chapter, and label them accordingly.

In the region between the formula bar and the status bar you will find the actual working part of the spreadsheet page. It starts at the top with a sequence of rectangles, each containing one letter of the alphabet on a gray background. It ends, at the bottom, with a bar containing a series of tabs;
one such tab, such as the one labeled Sheet1 in Fig. 1.2-2, will have a white background, indicating the currently open (or ‘active’) sheet, while the others will be gray. In between these is a rectangular array of blank cells. Each such cell can be identified by its (vertical) column and its (horizontal) row. Columns are labeled by the letters shown just above row 1 of the spreadsheet, while rows are labeled by the numbers shown to the left of column A. The cell at the top left of the spreadsheet is labeled A1, the one below it A2, the one next to A2 is B2, etc. One cell will be singled out by a heavy black border; that is the highlighted, active cell in which the spreadsheet anticipates your next action. The address of the active cell is displayed in the left-most window of the formula bar; in Fig. 1.2-1 it is cell A1.

To activate another cell, move the mouse so that the pointer, which should now have the shape of a hollow cross, is within that cell, then click. The corresponding cell coordinates will show on the left-most window of the formula bar. When you move the mouse pointer to another cell and click again, that cell will now become the active one. Note that the left-most window in the formula bar will track the coordinates of the active cell. Play with moving the active cell around in order to get a feel for manipulating the mouse.

A cell can also be specified by typing its coordinates. The simplest way to do so is by using the function key labeled F5. (The function keys are usually located above the regular alphabet and number keys, and labeled F1 through F10 or F12. On some keyboards they are found to the left of the alphabet keys.) A dialog box will appear, and you just type the coordinates of the cell, say, D11, and deposit this by depressing the large ‘enter’ key (to the right of the regular alphabet keys). Another way, initially perhaps more convenient for those used to DOS-based spreadsheets, is to use the keystroke sequence Alt + e Alt + g. Here Alt + e denotes that you depress Alt and then, while keeping Alt down, also depress e; follow this by Alt + g. Alt specifies that you want to select an item from the menu bar, e selects the Edit command, and g the Go to command, where the underlining indicates the letter to be used: e in Edit, g in Go, o in Format, etc. As a gesture to prior users of Lotus 1-2-3 or QuattroPro, you can even use the slant instead of the Alternate key: / + e / + g . Any of the above methods will produce the dialog box in which to type the cell coordinates.

Below we will usually indicate how to accomplish something by using the mouse. For those more comfortable with using the keyboard rather than the mouse, keystrokes to accomplish the same goals are often available. There is no need to memorize these commands: just look for the underlined letters to find the corresponding letter code. Using keystrokes is often faster than pointing-and-shooting with a mouse, especially when you use a track ball.

Note that, inside the cell area of the spreadsheet, the mouse pointer usually shows as a cross. Select a cell, then move the pointer away from it and back again. You will see that, near the border of the active cell, the pointer changes its shape and becomes an arrow. When the pointer shows
as an arrow, you can depress the left mouse button and, while *keeping it down*, move the pointer in the cell area. You will see that this will *drag* the cell *by its border*. By releasing the mouse button you can deposit the cell in a new location; the formula bar will then show its new coordinates.

Practice activating a set of neighboring, contiguous cells; such cell *blocks* or *arrays* are often needed in calculations. Move your mouse pointer to a particular cell, say cell F8, and click to activate it. You can now move the pointer away, the cell remains active as shown by its heavy border; also, the formula bar shows it as the active cell regardless of where you move the mouse pointer, as long as you don't click. Return the pointer to cell F8, and depress the left mouse button *without* releasing it, then (while still keeping the cell button down) move the mouse pointer away from cell F8 and slowly move it in a small circle around cell F8. You are now outlining a cell *block*; its size is clear from the reverse color used to highlight it (it will show as black on a white background, except for the cell with which you started, in this example F8, which will remain white, and which we will call the *anchor cell*). The size of the block will show in the formula bar in terms of rows and columns, e.g., 3R×2C will denote a block three rows high and two columns wide. By releasing the mouse button you activate the entire block, while the formula bar will return to showing the location of the anchor cell. You can then move away from it; the active block will remain. After you have selected the cell block, go back to it, grab its border (when the pointer is an arrow) and move the entire block around! To deposit the block in a new location, just release the mouse button. To abolish a block, release the mouse button to deposit it, then move the pointer to another cell and click on it.

To activate a block of cells from the keyboard, use F5 (or Alt + e Alt + g), then specify the block by the coordinates of its upper left cell and of its lower right cell, separated by a colon, as in D4:E9, and deposit it with the enter key.

There is yet another way to activate a block, starting from a single active cell. Again move the mouse pointer outside the active cell, but now approach the small square in the right bottom corner of the border around the active cell; this little square is the cell *handle*. The mouse pointer will change into a plus sign when it points to the cell handle; you can then drag the cell *by its handle* (rather than by its border) and make either columns or rows. Again, fix your choice by releasing the mouse button. You can drag it again to make a block out of a row or column. Practice these maneuvers to familiarize yourself with the mouse, and see how the pointer changes from a hollow cross (when you point at the middle of the cell) to an arrow (at its border) to a plus sign (at its handle). Below we will specifically indicate when to use the cell border or the cell handle; if nothing is specified, go to the center of the cell and use its standard pointer, the hollow cross.
1.3 A simple spreadsheet and graph

The spreadsheet is designed to facilitate making calculations, especially repeated calculations that would quickly become tedious and boring if you had to do them by hand, or even on a pocket calculator. (Unlike humans, computers do not tire of repetition.) The spreadsheet is also very useful when you have computations that would be too difficult for a pocket calculator. The tabular format, resembling an accountant’s ledger, helps us to organize the calculations, while the so-called ‘double precision’ of the spreadsheet keeps round-off errors in check. When you change one number somewhere in a spreadsheet, the computer automatically recalculates all cells that depend on the one you have just changed. (There are a few exceptions to this statement: special functions and macros do not update automatically. We will alert you when we come to them.) The spreadsheet also makes it very easy to construct graphs. We will demonstrate this now that you know how to move around in the spreadsheet.

Among the things we can place inside a cell are a **number**, a **label** such as a column heading, or a **formula**. A cell can hold only one of these items at a time. Activate cell A1 by clicking on it, then type the letter x, followed by depressing the ‘enter’ key, or by moving the mouse pointer to a different cell and by then clicking on that other cell. Either method will deposit the typed letter.

Activate cell A3; to do this, either move the mouse pointer to cell A3 and click, or use the down arrow to get there. In cell A3 deposit the number 0. (As with the letter x, nothing will happen until you deposit it, using the Enter key. This lets the computer know that this is all you want to enter, rather than, say, 0.3 or 0.0670089.) Be careful to distinguish between the number 0 and the letter O; they are close neighbors on the keyboard but they are completely different symbols to the computer. Similarly, don’t confuse the number 1, the lowercase letter L, and the capital I.

In cell A4 deposit the number 1. The letter x in A1 will usually show as left-justified (i.e., placed in the left corner of its cell), whereas the numbers 0 and 1 will usually be right-justified. (We hedge our bets with the ‘will usually be’ because all these features can easily be changed, as they may well have been on the computer you are using.) Return to cell A3, then activate both cells (by depressing the left mouse button while pointing to A3, keeping it down while moving to cell A4, then releasing the button). Both cells should now be active, as shown by their shared border.

Now comes a neat trick: grab both cells by their common handle (the little square at the right-hand bottom of their common border), drag the handle down to cell A11, and release the mouse button. With this simple procedure you have made a whole column of numbers, each one bigger by 1 than that in the cell above it!
Had you started with, say, the number 7 in cell A3, and 4.6 in cell A4, column A would have shown 7, 4.6, 2.2, −0.2, −2.6, and so on, each successive cell differing from its predecessor by 4.6 − 7 = −2.4. In other words, this method of making a column generates constant increments or decrements, in arithmetic progression. Try this, with different values in A3 and A4. Then go back to deposit the series ranging from 0 to 7 with an increment of 1 or, in mathematical notation, the series 0 (1) 7. Incidentally, there are many other ways to fill a column, some of which we will encounter later.

In column B we will now calculate a sine wave. Activate cell B1 and deposit the heading 'sine'. Move to cell B3 and deposit the formula \( \text{sin}(a3 \cdot \pi()/4) \). The equal sign identifies this as a formula rather than as text; the asterisk indicates a multiplication. The spreadsheet uses the notation \( \pi() \) to denote the value of \( \pi \); the brackets alert the computer that this is a function. Excel instructions do not distinguish between lower case and capitals, but the formula bar always displays them as capitals, which are more clearly legible. By now your spreadsheet should look like that depicted in Fig. 1.3-1.

If you were to extend the columns to row 11, the value shown in cell B11 might baffle you, since it may not quite be 0 but a small number close to it, reflecting computer round-off error. But don't worry: the error will usually be below 1 part in \( 10^{15} \).

There is a more convenient way to generate the second column. After you have entered the instruction \( \text{sin}(a3 \cdot \pi()/4) \) in cell B3, grab its handle (at which point the mouse arrow will show as a plus sign) and double-click. This will copy the instruction down as far as the column to its immediate right contains data! This is a very useful method, especially for long columns.

---

**Fig. 1.3-1:** Detail of the spreadsheet with its two columns and column headings.
1.3 A simple spreadsheet and graph

When there are no data to its immediate right, the column to its immediate left will do. When both are absent, the trick will not work.

Finally we will make a graph of this sine wave. Doing so is slightly different in Excel 97, Excel 98 for the Mac, or Excel 2000 on the one hand, and Excel 95 or Excel 5 on the other. We will here describe the procedure for each of these two versions.

Bring the mouse pointer to cell A3, click on it, drag the pointer (while keeping the mouse button depressed) to cell B11, then let go of the mouse button. This will activate (and highlight) the rectangular area from cell A3 through B11 (in spreadsheet parlance: A3:B11) containing the data to be graphed. Alternatively, you can highlight cell A3, then depress the Shift key, and while keeping this key down depress End, ↓, End, and finally →. (The sequence Shift + End, Shift + ↓ will highlight the column A3:A11, while Shift + End, Shift + → will include column B. As with double-clicking on the cell handle to copy an instruction, Shift + End looks for contiguous data.)

1.3a Making a graph in Excel 97 or a more recent version

If this is your first reading, and you use Excel 95 or Excel 5, skip the following, and continue with section 1.3b.

In Excel 97 or a more recent version, go with the mouse pointer to the menu bar, click on Insert, and in the resulting drop-down submenu click on Chart. Or achieve the same result with the keystrokes Alt + i, Alt + h. Either method will produce a dialog box labeled Chart Wizard – Step 1 of 4 – Chart Type.

In the list of Chart types, click on XY (Scatter); do not select the Line plot, which in Excel means something quite different from what a scientist might expect. The line plot can give you very misleading graphs because it presumes that the x-values are always equidistant.

As soon as you have selected the XY plot, the right-hand side of the dialog box will show five Chart sub-types: loose points, points connected by smooth or straight lines, or just smooth or straight lines. For now, pick the points connected by smooth lines – you can always change it later. (This is a general property of working with Windows Excel: you need not agonize over a choice, because there are almost always opportunities to change it later. So the best strategy is: when in doubt, pick something, move on, and worry about the details later.) Click on the Next > button.

Step 2 of the Chart Wizard shows the Data range selected. Also, under the Series tab, it shows which column will be used for X-values, and which for Y-values. The default (i.e., the assumption the spreadsheet makes in case you do not overrule it) is to use the left-most column of the selected block for X-values, so you need not take any action here, just press on with Next >. But it is handy to know that you can here, in step 2 of the Chart Wizard, change the assignments for X and Y.
Step 3 lets you enter a Chart title and axes labels. Click on the Chart title window, and enter Sine wave. Then click in the Value (X) Axis window, and enter angle. Finally, click in the Value (Y) Axis window, and enter sine. A picture will show you what your graph is going to look like.

There are other things you can specify at this point, such as the axes, gridlines, legends, and data labels, but we will forgo them here in order to keep things simple for now, and to illustrate later how to modify the end product. So, on to the Next >.

Step 4 defines the chart location, either As a new sheet, or As object in a spreadsheet page. Select the latter, and Finish. This will place the graph on the spreadsheet.

Now click on the graph, preferably inside its outer frame near its left edge, where the computer cannot misinterpret your command. This will adorn the graph with eight black handles, which allow you to change its size and location. First, locate the mouse pointer on the graph, depress the mouse button, and while keeping it down move the graph to any place you like on the spreadsheet, preferably somewhere where it does not block data from view. To release, simply release the mouse button. Note that the graph as it were floats on the page, and does not obliterate the underlying information. To fit the graph in the cell grid, depress the Alt key, then (while keeping Alt depressed) bring the mouse pointer to a handle in the middle of the side of the graph, where the pointer should change into a two-sided arrow, and pull that pointer toward a cell boundary. Repeat with the other sides. For greater efficiency you can combine this for two adjacent sides by pulling or pushing on two opposing corners.

In the final result, click on the little rectangular box to the right of the graph, then press Delete.

If you want to remove the gray background (which seldom prints well) just click somewhere in the plot area (where the label shows Plot Area), right-click, highlight Format Plot Area, and under Area either select None or, in the choice of colors, click on white. Exit with OK.

If you want to get rid of the horizontal grid lines, point to them (the label will identify Value (Y) Axis Major Gridlines), right-click, and select Clear.

To change the range of the x-scale, point to the axis (the label will show Value (X) Axis), right-click, select Format Axis, and under the Scale tab pick the scale properties you want. And, while you’re at it, please note that you can also change the font, size, color, position, and alignment of the numbers of the x-axis. Ditto for the numbers on the vertical axis.

To change the type of graph itself, point at the curve, right-click, and select Format Data Series. Then for the Line pick the Style, Color, and Weight you like, and for Marker the Style, Foreground and Background color, and Size.

And so it goes: you can point at virtually every detail of the graph, and modify it to your taste. Figure 1.3-2 shows you what you might have wrought.
1.3 Making a graph in Excel

If this is your first reading, and you use Excel 97, Excel 98, or Excel 2000, skip to the last two paragraphs of this section.

Go with the mouse pointer to the menu bar, click on Insert, and in the resulting drop-down submenu click on Chart. A second box will appear, which lets you select a graph either On the spreadsheet, or As a separate sheet. Select the former by clicking on it. You will now see a succession of ChartWizard boxes that let you specify how the graph should look. You can achieve the same result with the keystrokes Alt/i, Alt/h, Alt/o, Enter, with i for Insert, h for Chart, etc. Either method will produce a dialog box labeled Chart Wizard.

The first ChartWizard box, labeled Step 1 of 5, asks you what area of the spreadsheet you want to be graphed. Since you already selected that area, the window with the heading Range should show $A3:B11$. If it does, move the pointer to the Next button, and click. If it does not, first move the pointer to the Range window, click, if necessary replace its present contents by A3:B11 (use the Delete key located to the right of the enter key, type A3:B11, and click again to deposit this), then click on the Next button and proceed to step 2.

The second ChartWizard box lets you specify the type of graph you want. Click on the XY (Scatter) plot; your choice will be highlighted. (Do not select the Line plot, because it will automatically assume that all X-values are equidistant. This is convenient when you want to plot, e.g., income or expense as a function of the month of the year, or the region of the country. In scientific applications, however, it makes no sense to treat the X-values merely as labels, and it can yield quite misleading graphs.) Click on Next to move to the next ChartWizard.

1.3b Making a graph in Excel 5 or Excel 95

If this is your first reading, and you use Excel 97, Excel 98, or Excel 2000, skip to the last two paragraphs of this section.

Go with the mouse pointer to the menu bar, click on Insert, and in the resulting drop-down submenu click on Chart. A second box will appear, which lets you select a graph either On the spreadsheet, or As a separate sheet. Select the former by clicking on it. You will now see a succession of ChartWizard boxes that let you specify how the graph should look. You can achieve the same result with the keystrokes Alt/i, Alt/h, Alt/o, Enter, with i for Insert, h for Chart, etc. Either method will produce a dialog box labeled Chart Wizard.

The first ChartWizard box, labeled Step 1 of 5, asks you what area of the spreadsheet you want to be graphed. Since you already selected that area, the window with the heading Range should show =A$3:$B$11. If it does, move the pointer to the Next button, and click. If it does not, first move the pointer to the Range window, click, if necessary replace its present contents by A3:B11 (use the Delete key located to the right of the enter key, type A3:B11, and click again to deposit this), then click on the Next button and proceed to step 2.

The second ChartWizard box lets you specify the type of graph you want. Click on the XY (Scatter) plot; your choice will be highlighted. (Do not select the Line plot, because it will automatically assume that all X-values are equidistant. This is convenient when you want to plot, e.g., income or expense as a function of the month of the year, or the region of the country. In scientific applications, however, it makes no sense to treat the X-values merely as labels, and it can yield quite misleading graphs.) Click on Next to move to the next ChartWizard.

Fig. 1.3-2: The graph showing your sine wave.
The third box lets you define the data presentation. Let’s just select 2, which will show the individual data points in a linear graph, connected by line segments. If you want to see what the other presentation styles look like, try them out, either now or, better yet, after you have made your first few charts. Excel has many options, and often several ways to achieve each of them. Here we describe only a few simple ways to get you started, without confusing you with many possible alternatives. After you have become familiar with the spreadsheet, by all means play to find out how to move around in Excel, what all is available, and what formats and shortcuts you like; then use those.

The fourth box shows you a sample chart. The top right-hand corner will let you specify whether you want to plot rows or columns; we will usually plot columns, and that will most probably already have been selected. On to the Next step of the ChartWizard.

Step 5 allows you to add a legend, and to label the axes. If the question Add a Legend? is answered affirmatively, push the radio button to Yes. Point to the rectangular window under the heading Chart Title, click on it, then type a title of your choice, say, Sine wave, and deposit that title. Similarly, enter a legend for the X-axis (in the box next to Category [X]:), and a legend for the Y-axis (in the box next to Value [Y]:). That is all for now: click on the Finish button in the lower right-hand corner of the ChartWizard. You should see the graph, properly scaled, with tick marks and associated numbers, and it should look more or less like Fig. 1.3-2 (although there will almost certainly be differences in the exact scaling, letter type used, and so on, details that will not concern us here). If you had made the graph As a separate sheet, click the mouse on the tab labeled Sheet1 at the bottom of the spreadsheet; to go back again to the graph, click on the tab labeled Chart1, etc.

We will now add a few finishing touches. The numbers for the horizontal scale in Fig. 1.3-2 are placed just below the horizontal axis, at $y = 0$. It is nice that Excel selects and labels the scales for you, automatically, but you may want to have the numbers outside rather than inside the graph area. In that case, point with your mouse to a number with the horizontal axis, and click on it. This will result in two black blocks, one on each end of the axis, showing that you have activated the axis. Right-click to produce a small pop-up menu, and click on Format Axis, then select the tab Patterns, click on Tick mark labels Low, and end with OK.

Figure 1.3-2 contains the few points you have calculated, with connecting line segments. In this case, where we deal with a continuous function, it will look much better when we use a ‘French curve’ to connect the points with a smooth line. There are two ways to do so. The obvious one is to calculate more points per cycle, so that the points get closer together, the linear segments are shorter, and therefore more closely approach a smooth curve. The easier one (OK as long as you do not use the curve for precise interpolation) is to let the computer draw a smooth curve through the points, which
it will do with ease using what is called a **cubic spline**. You can do this as follows: double-click on the graph, click on a connecting line segment, right-click on it to get its properties, then click on Format Data Series. In the Format Data Series dialog box, click on Smoothed Line, followed by OK. That does it. The effect is shown in Fig. 1.3-3.

Finally, we change the font of the legends and labels. First get the Formatting toolbar with View ⇒ Toolbars ⇒ Formatting. Now click on the axis numbers, then in the Formatting toolbar select Times New Roman and, in the adjacent Font Size window, click on 12 (points). Do this for both axes. Then click on the axis labels and the graph title and adjust them likewise. It doesn’t matter whether you prefer the cleaner-looking sans-serif fonts like Arial, or the more readable serif fonts such as Times New Roman; the purpose of the present exercise is merely to show you how to change it to your taste. Incidentally, instead of using the Formatting bar you can click on, say, the axis numbers, and then use Format ⇒ Selected Axis to get the Format Axis dialog box, in which you can accomplish the same tasks as with the Formatting toolbar.

1.4 Addressing a spreadsheet cell

It is useful to go back to the spreadsheet and see what you have done. Bring the mouse pointer to cell B3, click on it, and observe the instruction shown in the formula bar: it should read = SIN(A3*PI()/4). Now move the pointer to cell B4 (again it should show a cross) and click on it. The formula bar will show the instruction as = SIN(A4*PI()/4). Move to the cell below, and examine its instruction: it will read = SIN(A5*PI()/4), and so on. Clearly, as you copied the instruction from cell B3 down, the **address** of the cell to
which the instruction referred was also pulled down, from A3 to A4 to A5 etc. This is called **relative addressing**, and is a main feature of all spreadsheets. In other words, the instruction refers to a cell in a given position relative to that of the cell from which it is called. It is as if the instruction reads: take the sine of π/4 times the contents of the cell to my immediate left. In copying a formula in a spreadsheet from one cell to another, relative addressing is the norm, i.e., the **default**, the operation you get without specifying anything special. An example of relative addressing in a different context is the movement of a knight on a chess board. In fact, most chess moves are relative to the starting position of the moving piece.

Sometimes we need to refer to a particular cell, for instance when such a cell contains a constant. In that case we must specify that we want **absolute addressing**: we do this by preceding both components of the cell address (its column letter and its row number) by that symbol of stability, the dollar sign. (We already encountered this notation in the previous section, where the block A3:B11 showed in the first ChartWizard dialog box as the range = $A$3:$B$11.) We can also protect the column but not the row, by placing a dollar sign in front of the column letter, or vice versa; we will occasionally encounter such **mixed address** modes in subsequent chapters. To return to our earlier analogy: the movement of a chess pawn is relative, except at its first move, or when it reaches the opposite end of the board, at which points its absolute address counts.

Now go back to column A, and examine its cell contents. Here we find no specific formula, but only numbers. The way we generated that column of numbers, by dragging its top two cells by their common handle, was convenient and quick, but did not give us much flexibility to change it later. If we anticipate that we might subsequently want to modify the contents of column A, here are two alternative ways to do so.

First, deposit the number 1 in cell F1. Then go to cell A4, and there deposit the instruction \( A3 + F1 \). (You can type it as shown or, faster, first type \( A3 + F1 \) followed by depressing the function key F4, which will insert the two dollar signs for you. Please don't get confused: F1 here means column F row 1, while ‘function key F4’ signifies the function key so labeled.)

Now copy this instruction down to cell A11; again, there are several ways to do this. They all start with cell A4 as the active cell; if cell A4 is not the active cell, make it so by clicking on it. Then try out the alternative methods described below:

(a) Depress the control key labeled Ctrl (there are two on the usual keyboard, one on each side of the ‘space bar’) and, with the Ctrl key down, also depress the letter c; this combination will from now on be denoted by Ctrl + c. (If you have been brought up with the DOS taboo never to use Ctrl + c, there are numerous other ways to do the same thing. For example, click on Edit in the menu bar, then on Copy, or use the keystrokes Alt + e Alt + c instead. You can also click on the copy icon in the icon bar, indicated by two
sheets to the right of the icon showing scissors. In Excel 95 and subsequent versions, you can point to the icon if you are not sure of its meaning, and wait one or two seconds: an explanatory note will appear to tell you its function.

Ctrl + c makes a copy of the active cell, and stores it in a place in the computer memory called the clipboard. Drag the active cell down to generate a column from A4 through A11 (make sure that the mouse pointer is the cross, so that you make a column rather than just move a single cell around), then paste the contents of the clipboard in this column with the command Ctrl + v (or Edit ⇒ Paste on the menu bar, the Paste icon on the icon bar, or Alt + e, Alt + p from the keyboard).

(b) When you want to make a long column, from A4 all the way to, say, A1394, it is more convenient to use the PageDown key rather than to drag the active cell. In that case we again start with copying the active cell with Ctrl + c. Now depress the Shift key while depressing the PageDown key until you are roughly where you want to be, and fine-tune with the up or down keys to reach your destination, all the time keeping the Shift key down. Release the shift key only when your column has the required length, then press Ctrl + v to paste the instruction from the clipboard into the now activated column A4:A1394.

(c) Even faster (for such a long column) is the following method. Activate cell A4, copy it onto the clipboard (Ctrl + c), then select the Goto function key F5. This invokes the Go To dialog box; in its Reference window type A1397, click on OK, and you will now find yourself in cell 1397. While keeping down the shift key, now select End and the arrow up key, ↑, then paste with Ctrl + v. Bingo.

The above methods illustrate the use of relative and absolute addressing. Now let us look at the result. Go to cell F1 and deposit the value 2; immediately, column A will show the sequence 0, 2, 4, 6, etc. Play with it, and satisfy yourself that the constant value stored in cell F1 indeed determines the increment. The constant in F1 can be a fraction, a negative number, whatever. Then go to cell A3 and deposit a new starting value, say –3. Again the data in column A adjust immediately, as do the values in column B that depend on it. You now have much more flexibility to modify the contents of column A, without having to reprogram the spreadsheet.

1.5 More on graphs

Graphs are such an important part of spreadsheets because most of us can take in the meaning of a figure much faster than that of formulas or of a column of numbers.

First we lengthen the columns in the spreadsheet to contain more data. Go back to the (left-hand) top of the spreadsheet; the fastest way to do so is with Ctrl + Home (i.e., by depressing Control while hitting the Home key,
which you will usually find in the key cluster above the arrow keys). Using any of the methods described in section 1.4, you can now extend column A3:A11 to A83, then go to cell B11 and double-click on its handle. Alternatively you can extend columns A and B simultaneously: highlight the two adjacent cells A11:B11, copy these with Ctrl + c as if they were one cell, go down to cell A83, use Shift + End + Up to highlight A12:A83, and paste with Ctrl + p. This will copy both columns.

The spreadsheet should now contain several complete cycles of the sine wave. However, the graph does not yet reflect this, because you had earlier specifically instructed it to plot A3:B11. Check that this is, indeed, the case. We will now modify this.

With the mouse, point to the line in the graph, and press the Enter key. You will see some points in the graph highlighted, while the formula bar will contain the graph range, in a statement such as =SERIES (,Sheet1!$A$3:$A$11,Sheet1!$B$3:$B$11,1). Quite a mouthful, but let that be so. Simply move your mouse pointer to that statement, specifically go to the 11’s in it, and change them into 83’s. Then press Enter; the graph will now show the entire set, B3:B83 versus A3:A83.

Instead of modifying Chart1 we can also make a new graph. Because our earlier graph was embedded in the spreadsheet, now make a separate graph. Embedding a graph has the advantage that you can see it while you are working on the spreadsheet, and the disadvantage that it tends to clutter up your workspace, and that (in order to keep them visible on the screen) embedded graphs are usually quite small. On the other hand, graphs on the spreadsheet can be moved around easily, because they float on the spreadsheet. Likewise, their size can be changed readily. (In Excel 97 etc., the two types of graph are treated as fully equivalent, and you can readily change them from one type to another. Activate the chart, then select Chart ⇒ Location and use the dialog box. Note that the Chart menu appears only after you have activated a chart, otherwise the same location hosts the Data menu label.)

The next two paragraphs are intended specifically for users of Excel 5 or Excel 95. If you use a more recent version of Excel, which treats embedded and separate charts the same way, you may want to speed-read (or skip) this part.

Highlight (activate) block A3:B83. (You can do this most conveniently as follows: go to cell A3 and, while keeping the Shift key down, press End →, then End ↓.) Click on Insert Chart, then select On this sheet. The mouse pointer will change into a cross with a small histogram attached, the histogram being Excel’s idea of a graph. Bring the pointer to the left top corner of cell D1, and click. Reenter the ChartWizard, which will show the highlighted area as = $A$3:$B$83. Click on Next. In step 2, select the XY(Scatter) plot, then click on Next. In step 3, select 2, then Next. In step 4 use Data Series in
Columns, Use First 1 Column(s) for X Data, Use First 0 Row(s) for Legend Text, then Next >. In step 5, add a Legend yes, Chart Titles: Sine wave, Axis Titles Category (X): angle, Value (Y): sine, then press Finish.

If you are adventuresome, make alternative choices and see what they do. There is no penalty for experimenting; to the contrary, this is how you will quickly become familiar with the spreadsheet. If you don’t like the choices you have made, select Back to back up in the ChartWizard steps, and change your choices; if you dislike the final result, just scrap it and start over again. To abolish the graph, bring the mouse pointer anywhere inside the graph area, click on it, then use the Delete key to abolish it. To modify it, highlight the curve and make your changes in the formula bar. You are in charge here, the spreadsheet is your willing servant.

Again, the graph you just made may need some adjusting. First let us do its positioning. Bring the mouse pointer to the graph (anywhere inside the figure or its edge will do) and click. The graph will now be identified by eight handles, one on each corner, and one in the middle of each side. These handles are there for you to grab if you want to move or resize the graph.

In order to move the graph as a whole rather than to resize it, click with the pointer anywhere inside the figure (but not on any handle), drag it to another place, then drop it there by releasing the mouse button. In order to move it again, click again on the graph, grab it, and this time move it right smack on top of the data in block A3:B83. As you will see, it does not matter: it really floats on top of the data, and you can pick up the chart again, and place it somewhere else on the spreadsheet, thereby freeing the A and B columns. These columns will emerge unscathed, since you did not erase them, but only placed an image over them. It is like the sun, which is not obliterated by a cloud moving in front of it, but is merely blocked from our view.

Now resize the graph. Activate the graph again, and go to the middle bottom handle. When you are on target, the pointer will change into a vertical double arrow. Now you can drag the handle, up or down. Likewise you can move the other borders. You can also grab a corner, which allows you to change the graph size simultaneously in two directions. If you like to nest the graph neatly inside the spreadsheet, you may want the borders to line up with cell boundaries. You can achieve this by depressing the Alt key while dragging the borders, in which case the graph boundaries will jump from line to line. Use this to make the graph fit the area D1:F9.

Place the label ‘second sine’ in cell C1. Go to cell C3, and deposit the formula $0.7 \sin(A3^{\pi}/16)$. (Note that you must use * to specify multiplication: $0.7\sin(A3^{\pi}/16)$ will not be accepted.) Copy this instruction all the way down to cell C83 by double-clicking on its handle. Now plot the second sine wave versus X, again embedding the graph in the spreadsheet. The more figures, the more fun!
Go to cell A3, and highlight the range A3:A83 (e.g., with Shift + End, Shift + ↓). Then release the shift key and, instead, depress the Ctrl key, and keep it down. With the mouse, move the pointer sideways to cell C83, release the Ctrl key, and use Shift + End, Shift + ↑, i.e., depress the Shift key, and press End ↑. You will now have marked two non-adjacent columns.

Click on Insert, Chart, On this sheet, place the new graph next (or below) the earlier one, and answer the ChartWizard; you already preselected the Range in step 1 as $A$1:$A$83,$C$1:$C$83. (When you prefer to type in the range rather than to point to it, this shows you the format to use, except that you can leave out the dollar signs: just type A1:A83,C1:C83.) Answer the other ChartWizard queries, look at the result, and if necessary reposition the graphs to resemble Fig. 1-5.

(In Excel 97 and later versions there is an even easier way: activate the plot, click on Chart Add Data, then specify the Range in the Add Data dialog box.)

Do you want to change the markers indicating the individual points? Click on a graph. Then position the mouse to point to a marker, and click again (sometimes it requires a few clicks) until a few markers are highlighted. At that point double-click, and a Format Data Point or Format Data Series dialog box will appear. (The latter is actually a whole series of boxes, each selectable by clicking on its tab. The top dialog box is labeled Patterns, and is the one to play with here.)

Either dialog box allows you to select or modify the type of plot: whether you want to show the data as a line, as points only, or as their combination; what color and line thickness you want for the line, and/or what type and color of markers you wish to use. Either box shows you what the line and marker will look like; click on OK when you are done making your selection, or on Cancel when you do not want any changes.

At this point you get the idea: once you have learned to ride this horse, it will do most anything you want from it to make life easy for you. You want to change the axes: click on them, then double-click, and a magic box will appear to ask for your wishes. You want to change the legend, the font used, whatever – the possibilities are endless. Most changes beyond the simplest use dialog boxes: they allow you to order your graphs à la carte.

Back to serious business: these graphs represent your spreadsheet data. Even if you now modify those data, the graphs will reflect the numbers in your spreadsheet. For example, go to cell B36, there deposit the instruction \[0.2 \cos(A36\pi/8) + \$G\$1\], then copy this down through cell B67. The top graph will immediately show the modification, because it plots column B.

Now go to cell C3 and modify it (again using the edit keystroke, F2) by adding to the already existing instruction \[\sin(A3\pi/16)\] a second term, \[+0.3 \times B3\], and deposit it (with the Enter key). Copy the instruction down to C83, by double-clicking on its handle. Look at the second graph, which represents column C: it now shows the sum of a sine and cosine wave, including the
1.5 More on graphs

modified section in column B, and the vertical scale has changed to accommodate the data. Then deposit a number in cell G1, and see what happens.

In the Chart Wizard we have encountered how to give the graph a title and how to label its axes; now we will see how to introduce annotating text anywhere in the actual graph. To activate the inner frame of the graph, locate the mouse pointer inside this inner frame but away from any specific feature such as a data point or curve, and click so that this inner frame becomes accentuated. Now click on the formula window (the larger window in the formula bar), type the text you want to introduce, and hit the enter key, whereupon the text will appear somewhere inside the figure, in a small box. As long as it is selected (as indicated by the surrounding box; which you can select again by clicking on it) and the mouse pointer shows as an arrow-tipped plus sign, you can move that box with its contents to any position in the graph. Moreover, you can change the properties of the lettering by moving the mouse pointer over it until it shows as a capital I, highlighting part or all of the text you want to be changed with the mouse key, and then, change its letter type, point size, color, etc. Try it out, and play with it. Again, in Excel 97 and subsequent versions, you can activate the graph, then use Chart ⇒ Chart Options to achieve the same result.

Fig. 1-5: The top of a spreadsheet with two embedded graphs.
Once you have a graph, it is easy to add another curve to it, provided it has the same x-axis. Merely highlight the column containing the new y-values, press Ctrl + c, activate the chart so that its inner (coordinate) frame is highlighted (this may require clicking twice inside that frame), then press Ctrl + v. This will convert a column of numbers into a new curve or set of points. The reverse process, removing a particular curve from a graph, is even easier: highlight the curve, erase its description in the formula bar, then press Enter.

How do we name the spreadsheet? Bring the mouse pointer to the tab at the bottom of the central area of the spreadsheet, which will show a generic name, such as Sheet1. Right-click on the mouse, which is the general method of gaining access to the properties of the item to which you point. Select Rename; in the resulting Rename Sheet dialog box, click on Sheet1 in the Name window, and replace it with your own choice of spreadsheet name.

Copying a graph embedded in a spreadsheet to another location on the same sheet merely requires that we activate the graph, copy it with Ctrl + c, then click on a new location and paste it there with Ctrl + v. Make sure that the spreadsheet shows a zoom value of 100%, otherwise the copy will differ in size from the original.

Copying a graph to another sheet is another matter. It is just as easy to do, but the graph you get will still refer to the original sheet, because the coordinates of the graphed columns or rows contain the name of the sheet. That may be just what you want, in which case everything is fine. However, when you copy a graph, or an entire sheet, including its graphs, to another sheet, and you want that graph to refer to the data on the new sheet, you must activate each curve and then, in the formula box, change the associated sheet name (just before the exclamation mark). The same, incidentally, applies to names. Regardless of how many worksheets you use, in one workbook a given name can only be assigned once.

When you copy a graph to another workbook, and want it to refer to its new environment, you must also change the workbook name.

How do we save the spreadsheet? When you are ready to stop, click on File, then on Save As. In the resulting Save As dialog box, a name of your choice should go in the window File name. The location where the spreadsheet will be saved is specified in the Save in window. If you don’t want to save in the My Documents file, click on the arrow to the right of My Documents. A list of options appears; select one of them by double clicking.

To end this section on a playful note: let’s move some of the embedded graphs around. Take one graph, and click on it while keeping the Ctrl button down. Now move the entire graph: you are moving a copy of it, the original remains in place! You can move it anywhere, deposit it by releasing the mouse button, pick it up again (or leave it, and only pick up a copy of it by using Ctrl) and move it all over the place. Drop it partway over another graph, or over data; it does not bother either of them, just temporarily blocks